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Automatic Speaker EQ 

The Automatic Speaker EQ algorithm is aimed at reducing the design time of speaker systems by 

automatically tuning filters to create the desired frequency response of the speaker. The algorithm is 

capable of tuning one, two, and three way systems. 
 

 

Algorithm Description 

The Automatic Speaker EQ is located in the ADI Algorithms section of the SigmaStudio Toolbox. Once included in 
the project, it is necessary to choose the proper algorithm for the current design. The Automatic Speaker EQ 
supports up to three-way speaker designs. 
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Source Tab 

When first opening the control, the source tab will be visible. This is where the response(s) of the desired speakers 
are loaded. Compatible formats include Impulse Responses with one measurement per line and Frequency 
responses in the MLSSA file format. 

 

 

Controls 

1. Impulse Response Radio Button – Click this to use an Impulse Response Measurement as the 

speaker response. Disables the Frequency Response file import. 

Notes:  

1. This program will load IR files in text (ASCII) format, one sample per line only and no header lines.  

 

2. The maximum IR window length is 10 milliseconds which limits the low frequency response to 100 Hz.  

  

3. Be aware of exactly how your program creates IR files.  For example, Room EQ Wizard (REW) does not 

include the effects of the microphone and soundcard calibration files when creating an IR file.  This can 

result in differences between a REW generated frequency response file and the IR file created from the 

same measurement. 

2. Frequency Response Radio Button – Click this to use a Frequency Response Measurement as the 

speaker response. The MLSSA file format is supported. Disables all Impulse Response related controls. 
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Several example MLSSA response files are included with SigmaStudio. Under a standard SigmaStudio 

installation, they can be found under your home directory: C:\Users\Username\Documents\Analog 

Devices\SigmaStudio 4.5\Projects\Speaker Measurement Samples\ 

3. Click to load Impulse Response 

4. Click to load Frequency Response 

Caution: Frequency Response (FR) files are normalized by Auto-EQ so each driver’s peak value is + 5 dB. 

This normalization removes any sensitivity differences between drivers and results in mismatched driver 

levels after using the Auto-EQ control.  To work around this problem the dB difference between the drivers’ 

peak values must be known before loading the files into Auto-EQ.  Most loudspeaker measurement 

programs have an overlay feature with gain controls which allow the user to easily calculate the sensitivity 

differences.  Several ways exist to compensate for the sensitivity differences.  For an example, assume a 

two-way speaker where the tweeter is 5.2 dB more sensitive than the woofer: 

 

a. Enter the sensitivity difference in the crossover tab.  The tweeter gain can be set to -5.2 to match the 

woofer's sensitivity.  The crossover response will look incorrect, but the measured woofer/tweeter levels 

will match. 

 

b. Add a gain control to the Auto-EQ tweeter output.  The gain (-5.2) has to be converted from dB for the 

gain control.  In this example the gain value = 10 to the power (-5.2/20) = 0.5495. 

5. Impulse Response Graph – The Impulse response will be displayed here. The blue curve represents 

the response. The red curve represents the window to be applied. Draggable points will appear to 

control the window start/length. 

6. dB Scale Checkbox – Click this to toggle a dB/linear scale in the y-axis. 

7. Window Control Knobs – These control the window start and length. Changes made via these knobs 

get reflected to the drag points on the Impulse Response graph. 

8. Apply Windowing Checkbox – This allows the user to turn off the window and use the entire impulse 

response measurement. 

9. Frequency Response Graph – The frequency response, whether from a file or calculated from the 

impulse response, will be displayed here. This is the raw frequency response of the speaker, before the 

Auto EQ has been calculated or applied. 

10. Offset Gain Control – Allows the user to change the level of the frequency response. 

11. Smoothing Control – Changes the smoothing of the frequency response that is calculated from the 

impulse response. 



Target Response Tab 

The next tab provides tools to allow the user to design the desired target response for each transducer. 

 

Controls 

BUG:  It some cases the source response will not be shown. This seems to occur only when using a 
frequency response file as the source. Return to the “Source Response” tab and reload the frequency 
response file. 

1. Design Controls 

1. Pointer Tool – Allows the user to create points by double clicking, or move pre-existing 

points 

2. Line Tool – Create straight lines 

3. Pencil Tool – Draw curves by hand 

4. Weighting Toggle – Enables the weighting graph. Changes made to the weighting graph 

affect how much the Automatic Speaker EQ algorithm will focus on those sections. 

2. Gain Sliders – These sliders change the overall gain of either the target or the source. Right click to 

view or change the numerical value of either slider.   

3. Individual Band Target Graph – Design the target using this graph. The blue curve is the source 

response. The target is defined by the drag points. 

4. Cutoff Points – These points define the frequency band that the Automatic Speaker EQ algorithm 

should design in. Areas outside these frequencies will be ignored. 
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5. Target From Filters Button – This allows for the target response to be made using filters instead of by 

drawing. A separate dialog box will appear with different filter types. Changes in this dialog are reflected 

in the target graph in real time. 

6. Match Source Response – This enables speaker modeling instead of speaker equalization. Checking 

this box will force the algorithm to create filters that match the response of the speaker. 

7. Combined Target Response Graph – This graph shows exactly which part of each speaker the 

algorithm is going to design for. In multiband designs, this graph will have different colored sections for 

each speaker. 

Design Settings Tab 

This tab provides controls to customize the operation of the Automatic Speaker EQ algorithm. 

 

Controls 

1. Show Advanced Settings – Displays the technical settings of the Automatic Speaker EQ algorithm. For 

information about Advanced Settings, see the Appendix. 

2. # Filters Control – This defines the number of filters that the Automatic Speaker EQ algorithm should 

use to match the target response. 

3. Low Cut – This defines the frequency of the low boundary for the Automatic Speaker EQ algorithm. 

4. High Cut – This defines the frequency of the high boundary for the Automatic Speaker EQ algorithm. 
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5. Initialize Filters – This will display a dialog that allows the user to initialize filters for the algorithm to 

use. Changes made in this dialog are displayed on the graph in real time. Note that initializing filters is 

not necessary for the algorithm to function properly. For more information, see the appendix. 

6. Design Filters Button – Pushing this button will initiate the Automatic Speaker EQ algorithm for the 

currently viewed speaker. 

Note:  The “Filters” tab is automatically selected at the end of the design process.  Patiently wait for that to 

occur before continuing. 

7. Include Crossover Checkbox – This checkbox is only enabled for multiband designs. It will apply the 

effects of the crossover to the Equalized response and Filters curves. 

8. Design Graph – This displays everything about the current design. 

9. Design All Button – This will initiate the Automatic Speaker EQ algorithm for all speakers. 

Filter Tabs 

After running the Automatic Speaker EQ algorithm, the Filters tab is automatically displayed. The Filters tab shows 
the results of the algorithm and allows the user to change the values of the filters as desired. The control is the 
same as the Parametric EQ included in Sigma Studio. 

 
 

 

Controls 
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1. Graph Controls – These control the x and y axis zoom, as well as allow the user to add and remove 

filters. 

2. Filter Table – This displays all the information available about each filter, as well as allowing the user to 

edit each parameter. 

3. Graph overlays 

1. Show Crossover Effects – Applies the crossover filter to the composite curve of all the 

filters. 

BUG:  If this option is selected the resulting Electro-Acoustic Response will be used as input to 

the “Crossover” tab, resulting an incorrect crossover graph.  To prevent this error deselect this 

option before viewing the “Crossover” tab.  

2. Overlay Source – Displays the source curve as a blue line on the graph 

3. Overlay Electro-Acoustic Response – Displays the result curve as a red line on the graph 

4. Overly Target – Displays the target curve as a green line on the graph. 

4. Export Results Button – Exports the filter coefficients in a text file to be used with the General 2nd 

order EQ filter included with Sigma Studio. 



Multiband Controls 

The multiband versions of the Automatic Speaker EQ algorithm contain two extra tabs to aid in designing a 
crossover for the system. 

Crossover Tab 

The crossover tab is the same as the crossover control included in Sigma Studio (*). The initial crossover points are 
set at the cutoff frequencies defined on the Target Tab. The user is then free to edit them as needed. 

(*)  Not entirely true.  The crossover tab in SigmaStudio offers many more crossover types. This tab only has 
Linkwitz-Riley filters (12, 24, 36 and 48 dB/octave).  To design using other crossover types:  

1.  Use the “Target From Filters” option in the “Target Response Tab”.  

2. Add SigmaStudio crossover controls to the Auto-EQ outputs.  Auto-EQ should be used just to flatten the drivers’ 
responses so a text book crossover can be used. 

In both of the above cases all crossovers in this tab should be disabled.. 

 

 

Controls 

1. Crossover Graph – This is the graphical display of the crossover response. There are two lines per 

band – the response of the filter and the response of the speaker after the filter is applied. 
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Feature: When the cursor is placed in the graph the expand/contract icons  will appear.  To 

expand a section of the graph click on the “+” icon and the cursor will change to a plus sign.  Then select a 

rectangular section (left click, hold and drag, release) to expand.  Click on the  contract (-) icon to cancel. 

2. Enable Control – In some cases it is necessary to disable to crossover filter. Uncheck this box to do so. 

3. Corner Frequency – Change the frequency of the crossover filter. 

4. Gain – Change the gain of the crossover filter. 

5. Filter Type – Change the type of crossover filter. 

6. Polarity – Invert the current band, if necessary. 

7. Link Enable – Link the frequencies of the two crossover filters. 

BUG: The Link Enable option does not seem to work. 

Crossover Tab Alignment 

Because the Automatic Speaker EQ uses IIR filters, the phase of the signal is affected. This creates a need to align 
the crossover filters to prevent unwanted cancellation due to phase irregularities. The alignment tab will help fix any 
phase-related cancellation and allow the user to fine-tune the system. 

 

 

Controls 
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Note: This tab is for informative purposes only.  Changing the delay in this tab does not change the Auto-EQ 

function or the depth of the null when the “Invert” option is selected in the “Crossover” tab.  To implement a 

delay requires adding a delay module to one the Auto-EQ outputs. 

BUG:  When this tab is selected the graph in the “Crossover tab can be changed which results with an 

incorrect crossover graph.  To correct this error: re-select the “Filters” tab, turn off the “Show Crossover 

Effects (if on) and toggle the “Overlay the Electo-Acoustic Response” option before viewing the “Crossover” 

tab.  

1. Alignment Controls – These add delay/gain to the currently selected speaker. Results are updated in 

real time on all graphs. 

Question:  What are the units of delay? This function really has no practical purpose without knowing the 

units.  

2. Individual Magnitude Graph – This graph displays the response of the currently selected speaker. 

BUG:  The magnitude graph is displayed only when using impulse response files. 

3. Individual Phase Graph – This graph displays the phase of the currently selected speaker. 

4. Auto Align Button – The Automatic Speaker EQ has a built-in alignment algorithm. Click this button to 

initialize the algorithm. 

BUG:  This button functions when using impulse response files, but generates the exception error shown 

below with frequency response files.   One work around is to select the “phase” graph and then manually 

enter delay values for the best phase match. 

 



 

Auto Align Exception Error 

 

5. Total Magnitude/Phase Graphs – These graphs display the total output of the system, as well as the 

phase of each speaker together on the same graph to aid in aligning the crossover. 



Filter Initialization/ Target From Filters 

The dialogs for defining a target from filters and for initializing filters are the same. 

 

1. Load/Save – It is possible to load and save both target filter information and initialized filters. 

2. Graph Controls – These control the scaling of the x and y axes. 

3. Add/Remove Filters – Add/Removed filters. This is also possible via double clicking on the graph or 

right clicking on the graph. 

4. Filter Table – This displays all the information about each filter. 

5. Fixed Checkbox – This only applies to the initialized filters. Checking this box will make the algorithm 

“skip over” that filter. It will be applied directly to the transducer without being optimized by the Automatic 

Speaker EQ algorithm at all. 

Some filters are fixed by default because they are special cases. Butterworth, Bessel, and Chebyshev filters are all 
special cases of high/low pass filters and cannot be modified by the algorithm. To have a high/low pass filter be 
optimized by the Automatic Speaker EQ, use the general high/low pass. 
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Advanced Settings 

The advanced settings are located on the Design Settings tab. They are hidden by default, but pushing the “Show 
Advanced Settings” button will make them appear. 

 

 Design Settings: 

o Post-Optimization Iterations – This defines how many passes the algorithm should make 

after designing filters while it tries to make the filters better. 

o Default Filter Q – The initial Q value for designed filters. 

o Peak Emphasis – How much weight to give to Peaks above the target. 

o Dip Emphasis – How much weight to give to Dips below the target. 

 Filter Tuning: Applies to both design and optimization loops. 

o Tuning Iterations – How many times the algorithm should change the filter parameters 

while trying to find the best fit. 

o Max Frequency Variation – The maximum allowable shift in filter frequency 

o Max Gain Variation – The maximum allowable change in gain of the filter 

o Max Q Variation – The maximum allowable change in Q of the filter. 

 Filter Constraints: 

o Q Min/Max – The smallest/largest Q value the algorithm can use when designing filters 

o Gain Min/Max – The smallest/largest gain values the algorithm can apply to filters. 

Menu Bar 

The menu on the Automatic Speaker EQ has some advanced functions associated with it. Under File, there are 
controls to load/save configurations. The Design menu has functions to import/export the target of the currently 
viewed tab, as well as to initiate the design process or reset the control. 
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